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1.0 Critical Information 
This section lists any critical issues for the current release that were known when this readme was 
published. For critical information found later, go to the Knowledge Center on the Empower website. 

None. 

http://documentation.softwareag.com/
https://techcommunity.softwareag.com/
https://techcommunity.softwareag.com/
https://empower.softwareag.com/
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2.0 Known Issues 
This section lists any issues for the current release that were known when this readme was published. 
For known issues found later, go to the Knowledge Center on the Empower website. 

▪ WED-9412 
Switching between the Pipeline and Data Mapper views applies smart mapping recommendations 
to a flow service without the user's acceptance. 
While using smart mapping recommendations for a flow service, switching between the Pipeline 
and Data Mapper views applies the recommendations even though the user does not click "Accept 
selected" or "Accept All". 
As a workaround, use smart mapping only in the Pipeline view or avoid switching between the 
Pipeline and Data Mapper views. 

▪ WED-9188 
Designer shows the following issues while creating a flat file schema from a sample file:  
- When you select delimited and variable length record parser types, Designer does not enable the 
focus on the "Next" button for the first time after providing the record parser details. 
- When you select "Delimited with fixed length fields" as record parser type, Designer does not 
recognize the record delimiter for the last record. 
As a workaround for the first issue, you need to click on the "Next" button twice. 
There is no workaround for the second issue. 

▪ WED-8826 
Designer does not enable the Edit menu options when assets are created using the File menu. 
While creating the assets using the "File > New" menu, Designer does not enable the Edit menu 
options, such as, 'Cut', 'Copy', and 'Paste' immediately after the assets are created.  
As a workaround for the issue, you can either change the selection to a different node under 
'Package Navigator' after the assets are created or create the assets using the right-click context 
menu. 

▪ WED-8695 
Designer does not expand the assets in the Package Navigator automatically when a consumer 
REST API Descriptor (RAD) is generated. 
In the Linux operating system, when a consumer RAD is generated, Designer does not expand and 
refresh the generated assets automatically in the Package Navigator view.  
As a workaround for this issue, right-click on the folder and select 'Refresh'; or press F5 to refresh 
the generated assets in the Package Navigator. 

▪ WED-9514 
Moving or renaming a gRPC descriptor, gRPC method flow service, or gRPC document type breaks 
the gRPC descriptor implementation. 
While Designer permits moving and renaming of gRPC descriptors and its associated artifacts, 
moving, renaming, or copying and pasting any of these elements breaks the gRPC descriptor. 
To place a gRPC descriptor and its artifacts in a different location, first delete the existing gRPC 
descriptor and then recreate it in the new location.  

https://empower.softwareag.com/
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▪ WED-8456 
Designer does not display the indentation ruler while creating a flat file schema for fixed length 
parser types.  
In Linux, while creating a flat file schema using a sample file for fixed length parser type, Designer 
does not display the indentation ruler for fields and subfields. 
There is no workaround for this issue. 

▪ WED-7129 
Logged Fields view fails to reflect the updated signature structure. 
If you merge a service signature structure, then the Logged Fields view does not reflect the updated 
signature structure. 
There is no workaround for this issue. 

▪ WED-7127 
Issues with compare and merge functionality for Adapter elements.  
In Designer, compare and merge functionality for Adapter elements allows you to track and merge 
changes from the same server or from different servers and from the version control history. 
However, the following issues exist with this functionality for Adapter elements:  
- Sometimes, comparing two adapter services that are created with the SELECT template fails after 
updating the element, as the compare editor highlights only the empty rows and cells.  
- For Adapter update Notification elements, row indexes are improperly calculated while merging 
the "Added" table data from left to right direction.   
- In some cases merging two different Adapter Services fails with following exception:  
"Internal error. Unexpected value at 
'com.softwareag.is.ui.diffmerge.internal.UndoableMergeDiffNodeOperation#addTypedAdapter: 
Expected 'com.softwareag.is.compare.structure.IComparatorElement', actual 'null'." 
There are no workarounds for these issues. 

▪ WED-6713 
In the IS Asset Compare view, you cannot merge the enabled or disabled property of a flow step or 
transformer obtained from comparing two Integration Server elements. 
There is no workaround for this issue. 

▪ WED-6227 
During refactoring, preview of the new and old value is unavailable for webMethods messaging 
trigger. 
There is no workaround for this issue. 

▪ WEL-6 
When you use Team Foundation Server (TFS) as your VCS client, TFS issues an 
IllegalArgumentException exception when sharing the local service development project. 
To work around this issue, clear the 'Connect mapped projects to TFS automatically' check box in 
Window > Preferences >Team > Team Foundation Server before sharing the local service 
development project. 
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3.0 Usage Notes 
This section provides any additional information you need to work with the current release of this 
product. 

▪ In version 10.11, a user has the option to change the Integration Server Administrator's password 
through the installer, which affects the way Designer connects to Integration Server at start-up. 

If the user chooses to change the Integration Server Administrator's password during installation, 
Designer creates a secure storage entry for Integration Server connection with host, port, user, and 
an empty password. However, in earlier versions, the default password provided by Integration 
Server was used, and Designer would automatically connect to Integration Server. Now, you must 
set the password in the server definition and connect manually. 

▪ WED-7369 
In Designer, on clicking the Authorize button and then the Close button on the Swagger UI tab of a 
REST API descriptor, the Swagger UI hangs. 
To work around this issue, close and open the Swagger UI. 

▪ XML Schema 1.1 is not supported on AIX.  
The Xerces library in AIX supports XML Schema 1.0 only. Attempts to use XML Schema 1.1 features 
on an Integration Server running on AIX results in schema syntax errors and the schema does not 
compile. 

▪ Web services functionality can be excluded from a Docker image created for a Microservices 
Runtime. 

Beginning with version 10.11, the web services functionality can be excluded from a Docker image 
created for a Microservices Runtime. If you use a Microservices Runtime in a Docker container as 
the local development server and the web services functionality is excluded from the container, you 
cannot create or modify web services descriptors or SOAP-JMS triggers. 
 

4.0 Fixes Included in Each Release 
This section lists the latest fix level that has been included in each release for each product component. 
A release is listed in this section only if changes occurred in that release. Go to the Knowledge Center 
on the Empower website for detailed information about fixes. 

Release 10.11 

▪ ESB_10.7_Fix2 

▪ ESB_10.5_Fix12 

▪ ESB_10.3_Fix19 

https://empower.softwareag.com/
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▪ ESB_10.1_Fix17 

Release 10.7 

▪ ESB_10.5_Fix9 

▪ ESB_10.3_Fix17 

▪ ESB_10.1_Fix15 

▪ ESB_9.12_Fix16 

▪ ESB_9.8_Fix10 

Release 10.5 

▪ ESB_9.12_Fix11 

▪ ESB_10.1_Fix9 

▪ ESB_10.3_Fix10 

▪ ESB_10.4_Fix2 

Release 10.4 

▪ ESB_9.9_Fix9 

▪ ESB_9.10_Fix9 

▪ ESB_9.12_Fix10 

▪ ESB_10.1_Fix7 

Release 10.3 

▪ ESB_10.1_Fix6 

▪ ESB_10.2_Fix2 

Release 10.2 

▪ ESB_9.6_Fix7 

▪ ESB_9.7_Fix10 

▪ ESB_9.8_Fix7 
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▪ ESB_9.9_Fix8 

▪ ESB_9.10_Fix8 

▪ ESB_9.12_Fix9 

▪ ESB_10.1_Fix3 

Release 10.1 

▪ ESB_9.6_Fix6 

▪ ESB_9.8_Fix6 

▪ ESB_9.9_Fix7 

▪ ESB_9.10_Fix5 

▪ ESB_9.12_Fix6 

▪ ESB_10.0_Fix2 

Release 10.0 

▪ ESB_9.5_SP1_Fix9 

▪ ESB_9.7_Fix9 

▪ ESB_9.8_Fix5 

▪ ESB_9.9_Fix5 

▪ ESB_9.10_Fix3 

▪ ESB_9.12_Fix2 

Release 9.12 

▪ ESB_9.10_Fix2 

▪ ESB_9.9_Fix3 

▪ ESB_9.8_Fix4 

▪ ESB_9.7_Fix7 

▪ ESB_9.5_SP1_Fix8 
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Release 9.10 

▪ ESB_9.9_Fix2 

▪ ESB_9.8_Fix2 

▪ ESB_9.7_Fix5 

▪ ESB_9.6_Fix5 

5.0 Other Resolved Issues 
This section lists the issues that were resolved in each release but were not part of the fixes listed in the 
previous section. A release is listed in this section only if changes occurred in that release. 

Release 10.4 

▪ WED-7612 
The Designer does not display the differences between two ForEach mappings of flow services. 
While comparing ForEach mappings between two flow services, Designer does not display the 
differences.  
The issue is now resolved. 

Release 10.2 

▪ WED-6898 
The Designer session keeps retrying a connection if sessions are not closed explicitly by the user. 
When a user does not close the Designer sessions explicitly, Designer restores the connection to the 
Integration Server with old credentials and Integration Server raises a flowTimeoutException. 
The issue is now resolved. Designer identifies the condition when credentials are invalid and then 
stops the connection. 

▪ WED-7121 
Unable to create web service descriptor from Designer.  
Creating a Web Service Provider and Consumer descriptor in Designer fails with following error: 
'http://apache.org/xml/features/disallow-doctype-decl&#39; not recognized. 
This issue is now resolved. 

Release 10.1 

▪ WED-6957 
Execute an Adapter service with InputFieldType (in the Which tab) 'java.lang.Byte' by providing a 
value that exceeds the limit, an error message appears informing the same. Later, if you execute the 
same Adapter service by changing the InputFieldType to 'java.lang.String', the same error message 
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appears preventing the service execution, even if you provide correct values. 
This issue is now fixed. 

▪ WED-6846 
In a transformer, if the output variables (Pipeline Out to Service Out or the reverse way)are 
mapped before the input variables (Pipeline In to Service In or the reverse way), the map step 
containing the transformer saves an incorrect value and hence, the flow service fails with incorrect 
results. 
This issue is now fixed. 

▪ WED-6434 
When using Designer to invoke the pub.flow:setResponseCode service, if the responseCode input 
variable value is set to 204, the Results view displays an exception. 
This issue is now fixed. 

Release 10.0 

▪ WED-6370  
Dropping an input array variable that is part of a ForEach mapping results in an exception. 
This issue is now fixed. 

▪ WED-6311 
Changes made in Pipeline view do not reflect in the Data Mapper view immediately. 
This issue is now fixed. 

Release 9.12 

▪ WED-6034 
Designer fails to handle the URL redirections while creating Integration Server elements. 
In Designer, if the URL has redirection, creation of Integration Server elements, such as web service 
descriptors, document types, and Integration Server schema from external URL fail. 
This issue is now fixed. 

▪ WED-5592 
Tooltips remain frozen in Designer. 
In Designer, the document or flow editor tooltips remain on the screen even after closing the editor 
using the keyboard shortcut Crtl+W. 
This issue is now fixed. 

▪ WED-5820 
Designer fails to display the details of Forms tab for Custom Remedy Adapter. 
Forms tab does not display the details of Custom Remedy Adapter service such as the 'Selected 
Form' details in Designer. 
This issue is now fixed. 

▪ WED-5611 
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Web service descriptor fails to generate xsd:any element and attributes when the 'Allow 
unspecified fields' property is set to true. 
The WSDL document for a web service descriptor does not include the xsd:any element and 
attributes when the web service descriptor uses a Document variable for which the 'Allow 
unspecified fields' property is set to true. This issue occurs even if the server configuration 
parameter watt.core.schema.createSchema.omitXSDAny is set to false. 
This issue is now fixed. 

▪ WED-5210 
When unresolved package issues are manually resolved in a Java service, Designer does not 
append the import details correctly to other Java services in the same folder of the package if they 
are also open in the editor. 
While editing Java services, upon doing an Organize Imports operation in a Java service, Designer 
removes necessary import details of other Java services that are in the same folder in the package if 
they are currently open in the editor. If the import details that are removed from the other services 
are manually resolved, the import details of the first service get corrupted, instead of getting 
appended to the existing import details. 
This issue is now fixed. 

▪ WED-6204 
The field name abbreviator, as used for XmlData, truncates the field names that start or end with '#'. 
When you run a flow service, Designer fails to display the parameter names that start or end with # 
in the Results window. The Field name abbreviator, as used for XmlData, truncates the field names 
that start or end with '#'. 
 This issue is now fixed. 

Release 9.10 

▪ WED-5339  
After installing a fix or a version of Integration Server that includes PIE-30233, a pipeline link (map 
or mapping) where the destination is a Document reference variable with an unresolved document 
type reference, behaves differently at run time. 
When executing the pipeline link, at run time, Integration Server ignores the field order defined in 
the target Document reference variable which results in unpredictable field ordering in IData. 
This issue is now fixed. 
Note: Integration Server versions 9.7, 9.8, and 9.9. 

▪ WED-5692  
There is no keyboard shortcut to drop variables from the pipeline. 
This issue is now fixed. Ctrl+Shift+O is the new keyboard shortcut to drop variables from the 
pipeline. 

▪ WED-5584  
While searching for Integration Server elements in all packages, Designer does not work as 
expected when installed with a non-English language pack.  
If you select All Packages option while searching for an Integration Server element in Designer 
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(Search -> Integration Server), Designer searches for the element in all the packages before 
displaying the results. However, if Designer is installed with a language pack other than English, 
Designer does not search for the element in all packages. As a result, no results are displayed. 
This issue is now fixed. 

▪ WED-5397 
Performance of Designer slows down when saving a flow service with many service references. 
While saving a flow service, Designer checks whether the services referenced in the flow service 
exists. As a  result, if there are a large number of service references in the flow service, the 
performance of Designer slows down. 
This issue is now fixed. A new flow service editor preference is introduced.  In the Flow Service 
Editor preferences page, if you do not want Designer to validate the referenced services while 
saving a flow service, clear the Validate service references while saving check box. Clearing this 
preference improves the performance of Designer while saving a flow service. By default, this check 
box is not selected. Select the Validate service references while saving check box if you want 
Designer to validate the referenced services while saving a flow service. 

▪ WED-5210 
When user selects Organize Imports to fix a JAVA service, it fixes the import statements of that 
service but the import statements in other JAVA services fails in the same folder. 
This issue is now fixed. 

▪ WED-5464 
If CentraSite is selected as the source of the WSDL or XML schema definition, Designer does not 
display the child organizations when creating a web service descriptor or an IS document type.  
When creating a consumer or WSDL first provider web service descriptor from a service asset in 
CentraSite or an IS document type from an XML Schema definition in CentraSite, Designer does not 
display the assets that belong to the child organizations.  
This issue is now fixed. Now, if Centrasite is selected as the source of the WSDL or XML schema 
definition when creating a web service descriptor or an IS document type, Designer lists the child 
organizations  

▪ WED-5465 
If you set the Pre-8.2 compatibility mode property to true for a web service descriptor using 
Designer, StackOverflowException occurs.  
If the web service descriptor contains a recursive document type reference, using Designer to set 
the Pre-8.2 compatibility mode property to true results in a StackOverflowException. 
This issue is now fixed. 
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6.0 Documentation Changes 
This section describes significant changes to the documentation, such as the addition, relocation, or 
removal of product guides, online help, chapters, or other major content. A release is listed in this 
section only if changes occurred in that release. 

Release 10.11 

▪ Service Development Help contains a new topic, “OpenAPI-Based Consumer REST API 
Descriptors” under the chapter “Working with REST API Descriptors”, which describes how to 
create a consumer REST API descriptor using an OpenAPI document. 

▪ Service Development Help contains a new topic, “Using Smart Mapping” under the “Mapping 
Data in Flow Services” chapter, which describes the functionality to simplify the mapping between 
the pipeline variables for MAP and INVOKE steps.  

▪ Service Development Help contains a new topic “Working with gRPC Descriptors” which describes 
how to create an executable IS asset from a gRPC service definition in a .proto file.  

▪ All UDDI-related contents are removed from Service Development Help including the “Working 
with UDDI Registry” chapter and the “UDDI Registry View Icons” and “UDDI Registry View 
Toolbar” topics. 

▪ The “Building Cloud Connector Services” and “Creating Connector Listeners” chapters are 
removed from Service Development Help and are available in “webMethods CloudStreams 
Connector Concepts Guide”. 

Release 10.7 

▪ Service Development Help contains a new topic, “OpenAPI Based REST API Descriptors”, which 
explains how to create a REST API descriptor based on an OpenAPI document and the details of 
the various assets that Integration Server generates. 

▪ Service Development Help contains a new topic, “Using the Cloud Service Development Feature”, 
which explains how to access the cloud service development perspective and use the feature. 

▪ Service Development Help contains a new topic, “Universal Messaging Preferences”, which 
explains the fields on the “Window > Preferences > Software AG > Universal Messaging” page.  

▪ Added a new topic, "Mapping Integration Server Content Type Constraints to Swagger Type 
Constraints" in the "Working with REST API Descriptors" chapter of the Service Development Help. 

▪ The contents of the “REST Developers Guide” are merged into the “Service Development Help” 
under “Working with REST API Descriptors” chapter and under a new chapter “Appendix”. 
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Release 10.5 

▪ Service Development Help contains a new topic,” Working with MQTT Triggers”, which explains 
what an MQTT trigger is and how to build an MQTT trigger using Designer.  

Release 10.4 

▪ The Configuring the VCS Integration Feature guide is no longer available, and the chapter entitled 
“Using the VCS Integration Feature to Check Elements in and Out of a VCS” is no longer part of the 
Service Development Help. The guide and related chapter explained how to use the functionality 
delivered in the WmVCS package to integrate Integration Server elements with a version control 
system. However, the WmVCS package is no longer delivered with Integration Server.  

Release 10.3 

▪ Service Development Help contains a new chapter,” Deploying to Cloud”, which explains how to 
deploy Integration Server packages and configuration assets (Integration Server and Universal 
Messaging configurations) to Integration Cloud using Designer.  

▪ Service Development Help contains a new chapter, Command Central Preferences, which explains 
how to customize Landscape navigator view, monitoring, and project settings for Command 
Central runtime components using Designer. 

▪ Service Development Help contains a new chapter, Integration Cloud Preferences, which describes 
the settings required for configuring an Integration Cloud connection. 

▪ Service Development Help contains a new chapter, “Working with Recipes”, which explains how to 
install or download and use recipes as a package using Designer. 

Release 10.2 

▪ Service Development Help contains a new chapter, “Publishing and Retracting Metadata for IS and 
TN Assets,” which explains how to publish and retract metadata for Integration Server (IS) assets, 
and Trading networks (TN) document types to and from the CentraSite shared registry. 

▪ The Developing Microservices with webMethods Microservices Container guide has been renamed 
Developing Microservices with webMethods Microservices Runtime to reflect the product name change 
from webMethods Microservices Container to webMethods Microservices Runtime.  

▪ Service Development Help contains a new chapter, “Working with WebSocket Endpoints”, which 
explains what a WebSocket endpoint is and how to create a WebSocket client endpoint and 
WebSocket Server endpoint. 
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Release 10.0 

▪ Service Development Help contains a new topic, Building Map Services, which explains what a 
map service is, and how to create a map service. 

7.0 Terminology Changes 
A release is listed in this section only if changes occurred in that release. 

Release 10.3 

Old Term New Term 

Named object Durable subscription or durable. 

As of Universal Messaging version 10.2, the term 
named object has been replaced with durable 
subscription or its abbreviated form durable. 

A serial webMethods messaging trigger 
corresponds to a serial durable subscription (or the 
abbreviated serial durable) on Universal 
Messaging. A concurrent webMethods messaging 
trigger corresponds to a shared durable 
subscription (or the abbreviated shared durable) on 
Universal Messaging.  

Release 10.2 

Old Term New Term 

webMethods Microservices Container webMethods Microservices Runtime 
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8.0 Added, Removed, Deprecated, or Changed Items 
This section lists functionality, controls, portlets, properties, or other items that have been added, 
removed, deprecated, or changed. A release is listed in this section only if changes occurred in that 
release. 

Release 10.11 

Added Item Description 

gRPC support Designer can create gRPC descriptors from gRPC 
service definitions. Developers can then implement 
the flow services that correspond to the gRPC 
methods. gRPC clients can invoke these services 
remotely. 

OpenAPI-based consumer REST API descriptor Users can create a consumer REST API descriptor 
using an OpenAPI document that conforms to the 
OpenAPI 3.0.x specification. 

Azul Java 11 runtime support for Designer 
Service Development 

Designer Service Development now uses the Azul 
Java 11 runtime environment instead of Java 1.8.         

Smart mapping  The feature predicts the possible mappings 
between the input and output of a pipeline for a 
flow service and displays the mappings 
categorized as 'Very likely', 'Medium likely' and 
'Little likely'. 

User interface to view deployable assets and 
include or exclude assets during deployment. 

While deploying Integration Server assets to a 
target environment, Designer displays the 
deployable assets that include the existing and 
deleted assets in the environment. Users can 
choose to retain or remove an asset from the 
deployment. 

New Java wrapper types for Object and Object 
List parameters. 

Designer now supports the 'java.math.BigInteger' 
and 'java.math.BigDecimal' Java wrapper types for 
the Object and Object List parameters. 

 

Removed Item Replacement, if any 

UDDI support in Designer  CentraSite, which is the default UDDI registry for 
Designer does not support UDDI v2 or v3 now. 
Hence, service development using UDDI registry is 
not possible and the UDDI-related functionalities 
are removed from Designer. 
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Changed Item Description 

Universal Messaging client window size for 
serial webMethods messaging trigger  

For a serial webMethods messaging trigger that 
receives documents from Universal Messaging, the 
corresponding client window size is now set to 1 to 
ensure serial processing order. Previously, 
Integration Server did not set the client window 
size for a serial webMethods messaging trigger. 
Instead, the serial trigger relied on the default 
value set in Universal Messaging, which is 100.   

Release 10.7 

Added Item Description 

Retention of the protocol buffer definition for a 
publishable document type that uses protocol 
buffer encoding.  

When you save a publishable document type for 
which protocol buffers is the encoding type, 
Integration Server creates a protocol buffer 
definition. The protocol buffer definition 
represents the structure and content of the 
document type as a protocol buffer, including the 
names, types, and attributes for the fields. 
Integration Server saves the human-readable 
protocol definition file named pdt.proto in the 
same location as the node.ndf for the publishable 
document type. Previously, Integration Server did 
not retain the protocol buffer definition. 

XML Schema Definition Language 1.1 support Integration Server now provides support for many 
of the features introduced in XML Schema 1.1. A 
detailed list of supported features and 
unsupported features can be found in the 
webMethods Service Development Help.  

Prefetch cache support for JMS triggers JMS triggers that receive messages from Universal 
Messaging can now use a prefetch, or consumer, 
cache. Each time the JMS trigger requests more 
messages from Universal Messaging, the JMS 
trigger can retrieve multiple messages which are 
then placed in a cache. The JMS trigger processes 
messages from the cache instead of requesting 
messages from Universal Messaging.  

OpenAPI based provider REST API descriptors Users can create a provider REST API descriptor 
using an OpenAPI document that conforms to the 
OpenAPI specification 3.0.x. 
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Added Item Description 

Delimited with fixed length fields record parser 
types 

When you create a flat file schema from a sample 
file, if each record is separated by a record 
delimiter and fields are of type fixed length, you 
can select “Delimited with fixed length fields” 
option. 

Create flat file schema without dictionary Clear “Create flat file schema with dictionary” 
check box if you want to create the flat file schema 
without a flat file dictionary. 

Configuring a Universal Messaging server When you want to deploy Universal Messaging 
configurations assets to Cloud Container, you must 
configure Designer to connect to a Universal 
Messaging server under “Window > Preferences > 
Software AG > Universal Messaging”. 

Choose the REST operations from the selected 
Swagger document 

While creating a Swagger based consumer REST 
API descriptor (RAD), you can select the REST 
operations to be included in the generated RAD. 

Support to view and debug the cloud assets 
using the Cloud Explorer view toolbar 

The Cloud Explorer view in Designer lists all the 
active solutions present in the Cloud Container 
along with the packages and Integration Server 
elements. 

Multiple packages can be moved to Integration 
Server packages directory 

You can select single or multiple packages and 
move them to the Integration Server directory by 
right-clicking the package(s) and selecting “Move 
Project to IS Package” in Package Explorer view. 

REST V2 resources support HTTP HEAD method Designer provides the HEAD option as one of the 
supported HTTP methods in the REST V2 resource 
editor. 

Environment variables can be used as values of 
substitution variables during ACDL- based 
deployment. 

When deploying to Cloud Container or any other 
ACDL-based deployment, the value of an 
environment variable can be used as the 
substitution value. 

Enhanced support for JSON Schema Integration Server offers enhanced ease of use 
while working with JSON Schemas. The enhanced 
JSON Schema feature provides lucid and easy to 
understand messages while creating and validating 
JSON documents using the built-in JSON schema 
services. With the enhanced support, JSON 
document types can be validated when used in the 
flow service signature at runtime. 
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Removed Item Replacement, if any 

Creation of REST resources and REST API 
descriptors using the legacy approach 

 

 

Changed Item Description 

webMethods Broker (Deprecated) property 
category 

The webMethods Broker (Deprecated) category 
name has been changed to Universal Messaging 
and Broker to reflect that the properties can be 
used with JMS triggers that receive messages from 
Universal Messaging as well as from Broker. Note 
that webMethods Broker remains deprecated.  

GraphQL Descriptor resolver service The output signature of the resolver services for a 
GraphQL Descriptor is modified.  
The $outputObjectType field is removed from the 
output of the resolver services and the $typeName 
field is added to all the object, interface, and union 
document types. However, the old resolver 
services that have $outputObjectType continue to 
work. 

Release 10.5 

Added Item Description 

Comparing package artifacts in the file system When comparing two packages, Designer recurses 
the file system directories for the packages and 
returns a list of differences for the package 
artifacts. 

MQTT triggers An MQTT trigger subscribes to a topic on an 
MQTT server and then specifies how Integration 
Server processes the messages the trigger receives. 

Support for GraphQL Dataloader Dataloader is a utility that improves the 
performance of your GraphQL query. Designer 
provides a graphical wizard to create Dataloader 
for a GraphQL descriptor. 

Option to include the API Name and Version 
during publish 

You can now specify an API name and version 
when you publish or republish a descriptor to API 
Gateway. 
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Added Item Description 

Support for the “readOnly” and “writeOnly” 
JSON schema annotations 

The new Read only and Write only properties in 
Designer provide support for the “readOnly” and 
“writeOnly” JSON schema annotations.  

Flat file schema wizard enhancement Designer provides a graphical wizard for defining 
a flat file schema for multiple and nested records. 

Creating consumer REST API descriptors Designer provides an option to create consumer 
REST API descriptors using the Swagger first 
approach. 

OAuth security schemes support for REST API 
descriptors 

Designer supports the creation of security 
definitions based on OAuth security schemes You 
can add these security definitions to REST 
resources and REST operations. 

Deprecated Item Replacement, if any 

Creating a REST Resource using the legacy 
approach 

None. 

Release 10.4 

Added Item Description 

API Gateway preference Integration Cloud preference page enables 
Designer to connect to Integration Cloud 
(Window > Preference > Software AG > API 
Gateway). 

The API Gateway metadata repository type 
in the Asset publish wizard helps a user to 
configure connections to API Gateway and 
publish assets.  

JSON schema Designer provides an option for creation of        
JSON document type from a JSON schema 
using the JSON document type creation 
wizard. 

GraphQL descriptor Designer provides an option for creation of                   
GraphQL descriptor from GraphQL 
descriptor creation wizard. 
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Added Item Description 

Swagger missing spec enhancements to REST 
API descriptor 

Designer provides the following Swagger 
specification options for a REST API 
descriptor:  
- Creating and associating security 
definitions and providing the reference to 
external documentation for REST operations 
and the REST API descriptor. 
- Creating and associating tags for the REST 
operations. 

Flat file schema wizard enhancement Designer provides a graphical wizard for 
defining a flat file schema. Developers use 
the wizard to upload a sample flat file and 
then identify the fields using a graphical 
click-and-configure interface.  

Deployment Status Tracking A new view ‘Deployment Status ‘is added 
under Window > Show View > Other… to 
view deployment status. 

Create a Rich Editor for run time configurations 
(YAML) in Designer feature 

Designer provides validation support for 
YAML content. 

Wrap response root element Specifies whether Integration Server should 
wrap the output signature and generate the 
root element for the REST response. 

Match payload with Swagger Specifies whether Integration Server should 
match the JSON format request payload for 
REST APIs as per the Swagger definition or 
according to the service input signature. 



20 

 

Deprecated Item Replacement, if any 

Web services implementation introduced in 
Integration Server 7.1. 

The current web services stack. Web service 
descriptors can be changed to work with the web 
services stack by changing the Pre-8.2 
compatibility mode property to false. A bulk 
change of web service descriptors can be 
accomplished using the built-in service 
pub.utils.ws:setCompatibilityModeFalse. 

Deprecation of the web services implementation 
introduced in Integration Server 7.1 results in the 
deprecation of the following: 

• The ability to run in pre-8.2 compatibility 
mode. 

• The Pre-8.2 compatibility mode property. 

• The Integration Server WS-Security facility 
which provides support for WS-Security by 
associating built-in WS-Security handlers to 
web service descriptors. 

Note: Securing web services using WS-
SecurityPolicy is not deprecated. For 
information about how WS-SecurityPolicy 
compares to the Integration Server WS-Security 
facility, including a comparison of policies 
provided for each, see the Web Services 
Developer’s Guide. 

• Any behavior specific to the web services 
implementation introduced in 7.1. 

For more information about the differences 
between the 7.1 web services implementation and 
the web services stack, see the “About Pre-8.2 
Compatibility Mode” section in the “Working with 
Web Services” chapter available in the Web Services 
Developer’s Guide or webMethods Service Development 
Help.  

Changed Item Description 

Path to Base Path The field name “Path” displayed while creating a 
REST API descriptor using a REST resource is 
changed to “Base Path”.  
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Release 10.3 

Added Item Description 

EXIT step Exit from property value $iteration The Exit from property now includes $iteration as 
a possible value to specify exiting from an iteration 
of the nearest ancestor LOOP or REPEAT flow 
step. 

Enhancements to REST V2 resources for JSON 
API support 

- Designer provides following options for JSON 
API support in the rest resource creation wizard: 
“Empty Rest resource and Document type based 
REST resource” while creating a rest resource.  

- Designer provides an additional tab called 
"Attribute configuration" for adding attributes to 
the REST V2 resource.  

- New property “Generate JSON API URLs” is 
added to the property view of a REST V2 resource. 

Integration Cloud preference Integration Cloud preference page enables 
Designer to connect to Integration Cloud (Window 
> Preference > Software AG > Integration Cloud). 

Support for Recipes in Integration Server / 
Designer 

A new view called ‘Recipes’ is added under 
Window > Show View > Other… for viewing, 
searching, installing, and downloading the Recipes 
in Designer. 

Support for try-catch block for flow services Designer provides the TRY, CATCH, and 
FINALLY flow steps to assist failure handling in 
flow services  

Additionally, Designer provides a new context 
menu option called “Transform to > Try Catch Step 
/ Try Finally Step” for SEQUENCE flow step.  

Designer displays a warning icon along with the 
message upon mouse hover in the flow editor for a 
semantically incorrect combination of the TRY, 
CATCH, and FINALLY steps.  

Deployment to Integration Cloud Using Designer, you can now seamlessly deploy 
your on-premise Integration Server packages and 
configuration assets to solutions present on 
Integration Cloud. 

Wrap response root element Specifies whether Integration Server should wrap 
the output signature and generate the root element 
for the REST response. 
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Added Item Description 

Match payload with Swagger Specifies whether Integration Server should match 
the JSON format request payload for REST APIs as 
per the Swagger definition or according to the 
service input signature. 

 

Changed Item Description 

EXIT step Exit from property The default value of the Exit from property is now 
$parent which indicates the flow will exit from the 
parent flow step, regardless of the type of step. 
Previously, the default value was <blank> which 
equated to nearest ancestor LOOP or REPEAT flow 
step. 

Serial webMethods messaging triggers that 
receive documents from Universal Messaging 
now process documents from a publisher in 
publication order in a load-balanced fashion.  

Previously, a webMethods messaging trigger with 
serial processing corresponded to a priority named 
object on a channel on Universal Messaging server. 
Now, a serial webMethods messaging trigger 
corresponds to a serial durable subscription 
(named objects in Universal Messaging are now 
called durable subscriptions). This provides 
processing in publishing order for a serial trigger 
in a cluster or a non-clustered group of Integration 
Server. Over time, it allows for the Integration 
Server in a cluster or non-clustered group to 
process messages in a load balanced fashion.  

Release 10.2 

Added Item Description 

WebSocket Endpoints You can configure a WebSocket endpoint that act as 
a server or client type. Implementation of 
WebSocket endpoints and its accompanying services 
enable you to develop and deploy applications that 
communicate with clients. 

Circuit Breaker You can configure a circuit breaker feature for a 
service that resides in a webMethods Microservices 
Runtime. To configure a circuit breaker with a 
service running on Integration Server, your 
Integration Server must have additional licensing. 
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Sync to DES property for IS document types Indicates whether Integration Server automatically 
synchronizes this document type with a 
corresponding Digital Event Services event type 
definition in the Digital Event Services repository 
upon save. Set this property to true if the 
document type is used to define the structure and 
content for the value of an “any” field in a 
document that is published to Digital Event 
Services. 

Enhancements to REST API descriptor - Designer provides a Swagger UI view that 
surfaces the open source Swagger UI and Try it out 
option developed for Swagger. 
- Swagger Syntax Coloring preference page is now 
available to set the font color and styles of tokens 
in a Swagger document. 
- Run option in the REST API descriptor editor 
enables execution of selected REST operations 
available in REST API descriptor. 

Enhanced support for REST V2 resources New properties are added to the property view of 
a REST V2 resource. 

 

Removed Item Replacement, if any 

Creating an IS document type from a file in 
webMethods Content Service Platform 

None. The webMethods Content Service Platform 
is no longer available.  

Release 10.1 

Added Item Description 

Support for REST V2 resources REST V2 resources provide a flexible way of 
defining resources for REST requests. In the Service 
Development perspective, a developer can define a 
REST V2 resource with operations that include the 
following: 

• The format of the URL that REST clients 
must follow when sending requests to Integration 
Server acting as the REST server. 

• The HTTP methods supported by the 
resource operation. 

• The flow service associated with a resource 
operation. 
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Added Item Description 

Support for REST API descriptors for REST V2 
resources 

In addition to creating REST API descriptors from 
resources that use the rest directive, the Service 
Development perspective now provides the ability 
to create REST API descriptors from REST V2 
resources. 

Support for REST API Descriptor from Swagger 
Document 

The Service Development perspective now 
provides the ability to create REST API descriptors 
from external Swagger documents accessible 
through a URL, a REST resource on API Portal, or a 
REST resource residing in CentraSite. 

Microservices Container running in a Docker 
container as local service development server. 

Designer provides support for the local service 
development feature to use a Microservices 
Container running in a Docker container as the 
local development server.  

 

Removed Item Replacement, if any 

REST Resource Configuration The REST Resource Configuration page of the 
Properties dialog box for a selected service option 
has been removed. 
An alternate option is provided through the 
creation of new REST V2 assets. 

Release 10.0 

Added Item Description 

Case sensitive check box  The Case sensitive check box in the Integration 
Server Search tab of the Search menu allows you to 
perform a case-sensitive search for the names of 
Integration Server elements. 

Exact match check box The Exact match check box in the Integration 
Server Search tab of the Search menu allows you to 
search for an Integration Server element with a 
name that exactly matches the specified search 
string. 

Map service Designer allows you to create map services that 
can be reused in different flow services. A map 
service can be used to map document types of 
different formats. 
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Added Item Description 

PATCH check box The PATCH check box in the New REST Resource 
configuration wizard of the Service Development 
perspective allows you to specify PATCH as a 
supported method for creating a REST resource. 

REST Resource Configuration The REST Resource Configuration page of the 
Properties dialog box for a selected service 
provides you with options to configure, edit, and 
delete REST resources for the service. 

Convert to Local Service Development Project Using the Convert to Local Service Development 
Project option in the context menu allows you to 
convert a non-Local Service Development package 
to a Local Service Development package by adding 
the VCS and Java project nature to packages that 
contain the Java and C/C++ services. 

ForEach debugging Designer now allows you to debug a ForEach 
mapping. 

Allowed HTTP Methods property The Allowed HTTP Methods property for a service 
enables you to select the HTTP methods that you 
can configure for the service. The supported 
methods are GET, HEAD, PUT, POST, PATCH, 
DELETE, and OPTIONS. 

 

Removed Item Replacement, if any 

Add VCS project Nature Convert to Local Service Development Project in 
the context menu allows you to add the VCS and 
Java nature to packages while you are working 
with local service development. 

 

Changed Item Description 

Port alias property For a binder in a provider web service descriptor, 
you can now set the Port alias property to the 
default provider endpoint alias when the binder 
uses the HTTP or HTTPS protocol.  
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Release 9.12 

Added Item Description 

Comparing and merging JMS triggers, adapter 
services, and adapter connections 

JMS triggers, adapter services, and adapter 
connections can now be visually compared and 
differences between versions can be merged. 
Previously, merging was available only for flow 
services and IS document types. 

Debug to Here Debug to Here option in the context menu allows 
you to debug a flow service up to the specified 
flow step. 

Data Mapper Data Mapper view in Designer allows you to 
execute, modify, and test a MAP step without 
saving the flow service. 

ForEach mapping Designer provides ForEach mapping approach in 
the pipeline view of a MAP step to simplify array 
mapping and array data processing. 

Move project to Integration Server package as 
linked resource 

Move project to Integration Server package as 
linked resource option in the Local Service 
Development Preferences, allows you to set any 
repository on your workspace as the local 
repository directory and a linked directory is 
created under the Integration 
Server_directory\instances\default\packages 
directory. 

Digital Event Services (DES) From Designer, a user can integrate with Digital 
Event Services using the existing webMethods 
Messaging infrastructure. Also, Annotations 
property is now available for publishable 
document types that use the 
IS_DES_CONNECTION messaging connection 
alias. 

Search and Refactor Search functionality now provides the ability to 
search for a variable and identify all references to 
that variable in other assets, such as flow services, 
document types, specifications, and triggers. 
The Refactor option in the context menu allows 
you to refactor the input/output variables of 
various Integration Server assets (for example, flow 
services, Java services, specifications, documents 
type). 
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Added Item Description 

API Portal The API Portal metadata repository type in the 
Asset publish wizard helps a user to configure 
connections to API Portal and publish REST API 
descriptors. 

Changed Item Description 

Processing mode property default The default processing mode for JMS triggers and 
webMethods messaging trigger is now changed 
from Serial to Concurrent. 
The value for ‘Max execution threads’ is changed 
from 10 to 1. 

Encoding type property default The default encoding type for publishable 
document type associated with a Universal 
Messaging connection alias is now Protocol 
buffers. Previously, the default encoding type was 
IData. 
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Release 9.10 

Added Item Description 

REST API Descriptor A descriptor for a group of REST services on 
Integration Server. 

Merging Integration Server Elements Merge capability allows you to merge the 
differences between two elements on the same 
server or on different servers. Merging is available 
for flow services and Integration Server document 
types. 

LCVI: Integration Server instance need not be 
named ‘default’ to use as LCVI. 

Multiple Integration Server local instances can now 
be made as Local Version Control Integration 
Server (LCVI). 

Validate service references while saving 
preference 

Flow service editor preference for validating all the 
referenced services in the flow service upon saving 
the service. 

Rest API Descriptor Preference Preference for specifying MIME type available for 
use with REST API descriptors. 

OData service creation from external sources OData service can now be created using an external 
source type. 

Changed Item Description 

REST Resource folder icon A folder that contains services that function as a 
REST resource now has a unique icon to 
differentiate it from a folder that does not contain 
any services or elements used as a REST resource. 

9.0 Copyright Information 
Copyright © 2021 Software AG, Darmstadt, Germany and/or Software AG USA Inc., Reston, VA, USA, 
and/or its subsidiaries and/or its affiliates and/or their licensors. 

The name Software AG and all Software AG product names are either trademarks or registered 
trademarks of Software AG and/or its subsidiaries and/or its affiliates and/or their licensors. Other 
company and product names mentioned herein may be trademarks of their respective owners. 

Detailed information on trademarks and patents owned by Software AG and/or its subsidiaries is 
located at http://softwareag.com/licenses.  

This software may include portions of third-party products. For third-party copyright notices, license 
terms, additional rights or restrictions, please refer to "License Texts, Copyright Notices and 
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Disclaimers of Third Party Products". For certain specific third-party license restrictions, please refer to 
section E of the Legal Notices available under "License Terms and Conditions for Use of Software AG 
Products / Copyright and Trademark Notices of Software AG Products". These documents are part of 
the product documentation, located at https://techcommunity.softwareag.com/and/or in the root 
installation directory of the licensed product(s). 

10.0 Support 
Visit the Empower website to learn about support policies and critical alerts, read technical articles and 
papers, download products and fixes, submit feature/enhancement requests, and more. 

Visit the Tech Community website to access additional articles, demos, and tutorials, technical 
information, samples, useful resources, online discussion forums, and more. 
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